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Chapter 1

Introduction to connections

ModuleConnectionsof SCIAEngineer hasbeenmade to design frame connectionsof steel structures.

While a connection is being entered in the graphical windows of SCIA Engineer, each element of the connection is drawn
(connected members, endplates, stiffeners, bolts, etc.). In addition, the program checks detailing requirements laid in the
code.What’smore, the allowable forceson the connection are calculated and theymust be comparedwith the actual forces
acting in the connection. The program also lists the parts that determine the resistance of the connection, thus enabling the
user to take appropriate actions.

After design and calculation, the program can generate overview drawings and detail drawings of the connection and the
connection elements. A report about the calculation can be printed.

The program isbased onEN 1993-1-8.

The algorithmsandmethodsdescribed in these referencesare used to calculate the limit statesof the connection. The capa-
cities of the underlying steel parts are calculated by the formulas given in the respective national codes (EC3, DIN18800 T1
or BS5950-1:2000), depending on the national code setup. For other codes the design of steel connections isnot available.

An overview of the used formulas for the specified steel parts is given 'Connect Frame Theoretical Background', Chapter
'Connection analysisaccording toDIN18800 andBS5950-1'.
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Connection types

Introduction to connection types
The program calculatespinned and rigid connections (connectionswhich transfer bendingmoment) . Rigid connectionsare
often not completely rigid, but allow a certain deformation. The stiffness of this connection is calculated by the program.
When the stiffness is low, it has to be taken into account in the calculationmodel to determine the internal forces in the struc-
ture.

The description of connection types that can be analysed in the program isgiven in chapters:

l Analysis types

l Geometric types

Analysis types
Frame bolted and welded connections
For the calculation of (semi)-rigid connections, the following characteristicsof connection are introduced in Eurocode 3:

l Moment Resistance

l RotationalStiffness

This design method allows us to determine a "Moment-rotation characteristic", which in turn allows us to represent the real
connection by a rotational spring connection defined in the centre lines of column and connected beam in the point of their
intersection (approximation to the real behaviour of the connection).

By using this method, the design of non-stiffened connections can be considered, which results in a reduction of the total
cost of structural steelwork.

The principles for the design of these semi-rigid connections are satisfied when the detailed application rules given in the
revised Annex J of Eurocode 3, Ref. [1] are followed. For the design of column bases, the application rules given in Annex L
of Eurocode 3, Ref. [5] are followed.

The following typesof connectionsare supported :

l Beam-to-column connections : Bolted endplate + welded connections (knee, T, cross - with continuous beam or con-
tinuouscolumn)

l Beam-to-beamconnections : Endplate type beamsplice (plate-to-plate connection).

l Column bases : Bolted base plate connection.

The types "beam-to-beam" and "column bases" are limited to symmetric and asymmetric I beams (including the elements
with variable height) andRHSsections, both for major-axisbending configurations.

For the type " beam-to-column", the beam element is limited to symmetric and asymmetric I beams (including the elements
with variable height) and RHS sections, both for major-axis bending configuration ; the column element is limited to sym-
metric I beams (including elementswith variable height) in major-axis configuration, and to symmetric I beams inminor-axis
bending configuration.

The following typesof stiffenersare supported :

Beam-to-column connection:
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l Haunches :Welded fromplate or made froma profile

l Webdoublers : Supplementaryweb plates

l Backing plates : On the flanges

l Stiffeners : Triangular + rectangular, positioned in beamor column

Column base connection:

l Haunches :Welded fromplate or made froma profile

l Stiffeners : Triangular + rectangular positioned in column at haunches

l Flangewideners

l Shear iron

Note: The frame connection can be defined between two beams (e.g. column and beam)
that must be perpendicular to each other in the "direction of connection". This on-the-spot-
invented phrasewill be best explained on a simple example.

Let usassume a column and a beammade of verticallyoriented I-section.

In the side view, the twomembersare not perpendicular.

In the plan view, however, theyAREperpendicular to each other. And this is the "direction of connection".

Therefore, the connection can be defined here.
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On the other hand, let usassume another column and a beammade of the same verticallyoriented I-section. At first sight (in
axonometric view) everything seems to be the same.

In the side view, the twomembersare perpendicular.

In the plan view, however, theyareNOT perpendicular to each other. And this is the "direction of connection".

Therefore, the connection cannot be defined here.

The same can be said for curved beams. If the curvature of the beam doesnot break the condition of perpendicularity in the
"direction of connection", the connection can be defined, see e.g. the picture below.
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Strong axis versus weak axis

Strong axis connection

Weak axis connection

Frame pinned connections
Frame pinned connections are connections that do not transfer anymoment. This is caused by the gap between the beam
flange and the column flange.

The following type of connectionsare supported:

l Beam-to-column connections (knee, T, cross).

The beamelement is limited to I-section andRHSsection, both for major-axisbending configuration. The column element is
limited to I-section inmajor-axisandminor-axisbending configuration.

The following typesof connection elementsare supported:
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l platewelded to beamweb andwelded to column flange,

l plate bolted in beamweb andwelded to column flange,

l angle section bolted in beamweb and bolted in column flange,

l short endplatewelded to beamweb and bolted in column flange.

Grid Pinned Connections
Grid Pinned connectionsare beam-to-beamconnections. Threemain formsare considered in SCIAEngineer:

l Welded pinned plate

l Bolted pinned plate

l Cleat

l Short end plate

The grid pinned connections are checked for critical shear force and normal force. The following critical situations are con-
sidered:

(1) VRd : design shear resistance for the connection element

(2) VRd : design shear resistance of the beam

(3a) VRd : design blockshear resistance for beamweb

(3b) VRd : design blockshear resistance for connection element (beamside)

(3c) VRd : design blockshear resistance for connection element (column side)

(3d) VRd : design blockshear resistance for endplate (beamside)

(4) VRd : design shear resistance due to the bolt distribution in the beamweb

(5) VRd : design shear resistance due to the bolt distribution in the column

(6) VRd : design shear resistance at the notch

(7) NRd : design compression/tension resistance for the connection element

(8) NRd : design compression/tension resistance of the beam

(9) NRd : design tension resistance due to the bolt distribution in the column

[(10) NRd : design compression resistance for columnweb]

For more information see TheoreticalBackgroundManual.

Bolted diagonal connections

Bolted diagonal connections
This chapter deals with the design and check of a bolted connection, where the member is subject to normal force. There
are 2waysof connection of the diagonal to another member (to a column):

l bolting the diagonal on a gusset plate,

l bolting the diagonalmember directly to the columnmember.
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Diagonal element bolted on a gusset plate
For both endsof the selected diagonal elements, gusset plate connection can be designed.

Possible configurationsare:

angle diagonal with single bolt row

angle diagonal with double staggered bolt row

channel diagonal bolted through flange with single bolt row

channel diagonal bolted through web with double (non) staggered bolt row

I section diagonal bolted through flange with double (non) staggered bolt row

- 14 -



Connection types

Bolt configurations

Angle section

Channel section
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I section

Gusset plate

Diagonal element bolted on a column
Both endsof the selected diagonal elementsare connected to the column element. The column element is an angle section.
The following configurationsare possible:
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angle diagonal with single bolt row

angle diagonal with double staggered bolt row

channel diagonal bolted through flange with single bolt row

channel diagonal bolted through web with single

channel diagonal bolted through web with double (non) staggered bolt row

Note: For bolt configurationssee chapter Diagonal element bolted on a gusset plate.

Multiple diagonal elements connected to one column
The selected diagonal elements (1 or 2 elements) are connected by means of 1 single bolt to the column element. The
column element isan angle section or a cold-formed section. The following configurationsare possible:
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angle diagonal(s) on angle column

cold formed diagonal on cold formed column

RHS diagonal on cold formed column

Properties of bolted diagonal connection
The connection propertiesconsist of several input parts. Each part can be edited on a separate tab sheet.

General Defines the connection name and comments.

Connection Sets the element and plate properties.

Bolts configuration Defines the bolt configuration.

Gusset properties
2D Plate group

[Material]
Use this button to select the material property for the gusset plate. The default material is taken from the diag-
onal element.

Thickness Defines the thickness of the gusset plate

Throat
thickness

Defines the weld throat of the gusset plate.When the value of "0.0" is input, the weld size during the cal-
culation is considered as a half of the gusset thickness.

The weld size is used to calculate the necessary weld length for the gusset plate.
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First diagonal element group

N
The critical normal force is displayed. Depending on the settings, the normal forces is the critical trac-
tion force or the critical traction/compression force.

Short, Long
Web, Flange

Use this radio button to select the proper part of the section for bolting the gusset plate.

Angle section - Short : bolted in short leg

Angle section - Long : bolted in long leg

U section - Web : bolted through web

U section - Flange : bolted through flange

Type Column I and Column II
For each angle diagonal, the position isdefined.

Diagonal position group
Position 1 Diagonal is inside the angle column.

Position 2 Diagonal is outside of the angle column.

Position 3 Diagonal is outside of the angle column (crossing the leg of the angle column)

Up Leg of the angle diagonal is on the upper side.

Down Leg of the angle diagonal is on the lower side.

Position 1

Flange Up

Position 1

Flange Down
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Position 2

Flange Up

Position 2

Flange Down

Position 3

Flange Up

Position 3

Flange Down

Bolt configuration
These groupsare valid for all types.

Bolts group
[Bolt] Use this button to define the bolt characteristics.

Hole d Display of the related bore hole for the bolt. The default value is taken from the bolt characteristics.

Bolts position group
One row Defines the number of rows.
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Two rows

No. in one
row

Defines the number of bolts in one row.

[Optimisation]
Use this button to let the program search for the number of bolts, with respect to capacity of the con-
nection.

p1
Defines the spacing p1 between the bolts on a row.

The default value can be set in the basic settings for each bolt diameter.

p2, w Defines the spacing p2 between the bolt rows.

staggered

non-
staggered

Defines the bolt staggering.

s
For staggered bolt position, defines the staggered pitch, the spacing of the centres of two consecutive
holes,measured parallel to the member axis. The default value is p2/2.

First diagonal group

e1
Defines the end distance in the first diagonal.

The default value can be set in the basic settings for each bolt diameter.

we2 Defines the edge distance in the first diagonal.

Second diagonal group
Thisgroup isvalid for the 'Column II' type.

e1
Defines the end distance in the second diagonal.

The default value can be set in the basic settings for each bolt diameter.

we2 Defines the edge distance in the second diagonal.

2D Plate group
Thisgroup isvalid for the 'Gusset' type.

e1
Defines the end distance in the plate.

The default value can be set in the basic settings for each bolt diameter.

e2
Defines the edge distance in the plate.

The default value can be set in the basic settings for each bolt diameter.

Column group
Thisgroup isvalid for the 'Column I' and 'Column II' type.

we2 Defines the edge distance in the column.

View bolt limits
Check thisbox to visualize the bolt limits in the diagonal and column elements.
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Geometrical configurations
Geometrical configurations for w, e1, e2, p1, p2, s

Default values
Default values for w, e2, p2, s
The default values for standard sections are stored in the profile library: the properties 74, 75 and 76 describe the default
bolt positions in the element.

Property number Description

74 w1

75 w2

76 w3

If the valuesw1, w2 andw3 are not present in the profile library, the following defaultsare used :

Default values w and p2 for angle sections
1 bolt line

w

2 staggered

bolt lines

w

2 staggered

bolt lines

p2

equal legs

w1<>0

w2=0

w1 b/3 b/3

equal legs

w1<>0
b/2 w1 w2
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w2<>0

equal legs

w1=0

w2=0

b/2 b/3 b/3

unequal legs

long leg

w1<>0

w2=0

w1 b/3 b/3

unequal legs

long leg

w1<>0

w2<>0

b/2 w1 w2

unequal legs

short leg

w3<>0

w3 b/3 b/3

unequal legs

short leg

w3=0

b/2 b/3 b/3

Default value w for U sections
w

flange connection

w1<>0
w1

flange connection

w1=0
b/2

web connection h/2

Default values w for I sections
w

w1<>0 w1

w1=0 b/2
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Default values e2 for RHS sections

The default values for e2 ish/2.

Default values e2 for cold formed sections
The default bolt configuration is stored in the profile library : the properties 67,48, 142,143 describe the element thickness
and the default bolt positions in the element.

Property number description

67 s (thickness)

48 B (width)

142 sp (number of shear planes)

143 E2

The default value e2=B-E2.

Geometric types
Introduction to geometric types
According to its geometry, a connection can be sorted into specific group. SCIA Engineer enables the user to deal with the
following groupsof connection:
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knee

simple T

double T

cross

plate-to-plate
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base plate

Note: In all types, the continuous element is called column, the element where the con-
nection is situated, is called beam.

Supported cross-section types
The SCIA Engineer Connections module supports a limited number of cross-section types that may appear on connected
beams. SCIAEngineer can dealwith the following cross-section types:

rolled I beam

RHS –rolled hollow section

built up I section (made of a flat and T section)
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symmetrical welded I section (made of three flats)

asymmetrical welded I section (made of three flats)

I section with a haunch

(elements with variable height)
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Connection parts

Connectors
Introduction to connectors
Connectors, as the name suggests, connect two part together. In SCIA Engineer the user may come across two types of
connectors: boltsand anchors.

Bolts are used for connection of two steel parts together. Anchors appear at base plate and connect the steel plate to a con-
crete base.

Bolts
Boltsare used together with appropriate washersand nuts.

Bolt
Boltsare defined by the following parameters:

l bolt description

l bore hole

l construction diameter (=diameter required for bolt key)

l head diameter (see s in Fig. below)

l diagonal head diameter (see e in Fig. below)

l head height (see k in Fig. below)

l grosscross-section Aof the bolt

l tensile stressareaAsof the bolt
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Nut
Nutsare defined by the following parameters:

l nut description

l nut diameter (see s in Fig. above)

l nut diagonal diameter (see e in Fig. above)

l nut height (seem in Fig. above)

Washer
The following propertiesdefine awasher (see Fig. below):

l washer description

l washer dimensionD

l washer dimension t

l washer dimension d2

l washer material

Bolt length
Astandard bolt length can be defined in 2ways:

l by the relation standard length - grip length,
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l by adding a specific value "delta" to the grip length : the standard length is given by (grip+delta+nut height+number of
washersxwasher thickness), rounded to following standard length,

Bolt pattern
Depending on geometrical conditionsand on load the connection is subject to, there can be used variousbolt patterns.

one bolt per row
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two bolts per row

three bolts per row

four bolts per row

Anchors
SCIAEngineer supports several anchor types:
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1. straight anchor

2. hooked anchor

3. curved (bended) anchor

4. anchor with circular plate (washer plate)

Straight, hooked and curved anchor

la calculated anchor length

t base plate thickness

d anchor diameter

lo overlength = f1 x d, default value f1=2

lh retourlength hooked anchor = f2 x d, default value f2=5

lc retourlength curved anchor = f3 x d, default value f3=5

Rh inner radius hooked anchor = f4 x d, default value f4=1.5

Rc inner radius curved anchor = f5 x d, default value f4=3

Note: Values f1, f2, f3, f4, f5 are input valuesand depend on anchor type.

Anchor with a circular plate
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l anchor length

t base plate thickness

d anchor diameter

lo overlength = f1 x d, default value f1=2

lp overlength at circular plate = f6 x d, default value f6=3

t1 thickness circular plate

R radius circular plate

d1 distance from anchor to side of concrete block

Note: Values f1, f6, l, d1 are input values. ValuesR, t1 are calculated byprogram.

Welds
Introduction to welds
Weld isdefined by:

l weld dimension

l weld length

l weld position

l weld type

Weld types

1 fillet weld

2 double fillet weld

3 bevel (HV) weld

4 square weld

5 plug weld

6 weld length at haunch

Note: Wed symbol (6) is not defined in codes. This symbol is used to represent the weld
length which is calculated for haunch analysis. In the graphical representation, symbol (6)
or symbol (3) can be used for depiction of weld size at haunches.
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Weld graphical symbols

Graphical representation of weld ismade by the above shown welding symbol. The letter X stands for the weld size, and Y
for theweld symbol. The circle symbol in (2) is theweld-all-around symbol.

The example on the right in (3) means : fillet weld of 6mmweld size.

Fillet weld

Possible applicationsof fillet weld are:

l short endplate / beam flange,

l closing plate,

l smallweb doubler,

l welded pinned plate.

Double fillet weld

Double fillet weld can be used in numerousapplications:

Bolted connection
l endplate / beam flange,

l endplate / beamweb,

l haunchweb / beam flange,

l haunchweb / end plate,

l stiffeners.

Welded connection
l column flange / beam flange,

l haunchweb / column flange,
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l stiffeners.

Pinned connection
l endplate / column flange.

Bevel weld

Possible applicationsof bevelweld are:

l haunch flange / endplate,

l haunch flange / beam flange,

l haunch flange / column flange.

Square weld

Possible application of squareweld is:

l largeweb doubler.

Plug weld

Possible application of plugweld is:

l weld sizeweb doubler.

Plates
Introduction to plates
Plates in connectionsmayhave various roles:

l endplate

l stiffener
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l backing plate

l web doubler

l flangewideners

l pinned plate

l short endplate

End plate
An end plate is a rectangular plate attached to the end of a beam. One of bolt patters can be used to connect the plate with
column.

Stiffener
The geometryof stiffener isdefined by the position and the shape. There are two option:

l rectangular stiffener (the left hand side of the picture below),

l triangular stiffener (the right hand side of the picture below).

Possible positionsof stiffenersare summarised in the following table and shown in the accompanying pictures.

Rectangular stiffener
1 column web, at top side

11 closing plate at top side

2 column web, at bottom side

3 column web, between bolts

4 column web, diagonal

5 beamweb, at haunch end

Triangular stiffener
6 column web, at top side

7 column web, at bottom side

8 column web, between bolts

9 beamweb, at haunch end
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Backing plate

The bolt pattern used for the backing plate dependson the pattern of associated end plate.

Web doubler
Aweb doubler can be used to increase the strength of the columnweb.

Flange widener
Flangewidener isused to increase thewidth of a flange.

Pinned plate
The pinned plate can be:
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l bolted and/or welded,

l one sided or two sided.

Short endplate

Sections
Shear iron
The shear iron has following section forms:
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rolled I

angle section
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Cleat

Notches
Notch
The notch isdefined bydepth h, length l and radius r. The notch can be situated at the top, and/or at the bottom flange.

Rounding of a notch
The rounding r of the notch, can be

0 no rounding

> 0 r = diameter of rounding

< 0 |r| = diameter of bore hole
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Haunches
Haunch
The connection may be "stiffened" by a haunch. Such a haunch is used for the purpose of the design and check of the con-
nection (read carefully the note below).

Type Member select

The haunch is made from a selected type of cross-section. The list is limited to cross-sections used in the
model of the structure.

Plate

The haunch ismade of one flat.

With flange

The haunch ismade of two flats – web and flange.

Input type Height x angle

Height x length

Cross- sec-
tion

If Type is set to Member select, the cross-section can be selected here.

Dimensions The required dimensions of the haunch can be input here.

The list of dimensions differs according to the selected Type.

Note: Adds a haunch to the connected beam. This haunch (i) affects the check of the con-
nection, (ii) is taken into account when calculating the "substitute" stiffnessof he connection
(if option Update stiffness is ON), BUT (iii) is ignored in the calculation model itself (unlike
the haunch defined bymeansof function Structure >Haunch.
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Designing a connection

Defining a new connection
Significance of defined beam types
When the user defines a new beam in his/her model, he/shemay specify the type of the beam. The type is of no importance
as far as determination of internal forces and stresses is in question. However, once the user startswith detailing and wants
to design a connection of two or more beams, the parameter Type comes into effect. Each type is associated with a specific
priority. The priority controls theway two beamsare connected to each other.

It can be simply said that the type specifies priorities of individual beams, in other words which beam is the "master" and
which one only the "slave", which determines the detailed geometryof the connection.

Let’s demonstrate the said on a simple example. Let’s assume a connection of two beams: vertical one and horizontal one.
There are three possible configurationsof such a detail.

vertical beam horizontal beam connection

type = column

priority = 100

type = beam

priority = 80

knee connection

type = beam

priority = 80

type = column

priority = 100

knee connection
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type = beam

priority = 80

type = beam

priority = 80

plate to plate connection

Adjusting the default parameters
Before the design itself, the user may specify values of various connection-design-related parameters. These valueswill be
then used asdefault values for individual particular connections.

General data
This group of parameters covers the basic data such asminimal weld size, slip factor for preload bolts, minimum distances
between bolts, etc.

Minimumweld size Minimum throat thickness of the welds.

Slip factor (preloaded bolts)
This is the slip factor m for preloaded high-strength bolts (see EC3,
6.5.8.3).

Factor for moment of prel. bolts

This factor k is used to determine the needed torque Mv.

Mv = k d Fv

where

Mv = torque

d = diameter of the prestressed bolt

Fv = design preloading force

Minimum distance bolt - edge plate (d) Minimum edge distance.

Minimum distance bolt - top plate (d) Minimum end distance.

Maximum distance bolt - edge plate (d) Maximum edge distance.

Maximum distance bolt - top plate (d) Maximum end distance.

Minimum distance between bolt rows (d) Minimum spacing.

Maximum distance between bolt rows (d)  Maximum spacing.

Minimum distance between bolt on rows (d) Minimum spacing.

Distance bolt – top/edge plate (pinned con-
nection)

Default bolt position in bolted frame pinned connectors.

Adapt analysis stiffness Default setting for adapting the stiffness during analysis.
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overdepth for notch

overlength for notch

Frame bolted / welded
Thisgroup determines theway inwhich a frame connection isdesigned and calculated.

Transformation
of efforts

Specifies which internal forces are used as solicitation forces :
In axis : internal forces in the node (intersection of beam and column axis).
In edge : internal forces at the connection

Weldsize
haunch

The presentation of weldsize at haunches can be either a fillet V weld, or the length as given in chapter
Weld sizes for haunches in Frame Connect : Theoretical Background.

Allowable rel-
ative error for
limit moments
(%)

This is the permissible exceeding percentage of the Moment design resistance Mj,Rd, for a connection
to still be classified asOK.

Omitting weld
in beff (FcRd)

This is related to formula J.19 & J.20 of Ref. [1]. It is possible to omit the portion of the welds in the
determination of the effective width beff, which is used to determine the design resistance of column
web to transverse compression (Fc,wc,Rd).

Include stress
in column
flange

This is related to the use of the reduction factor kfc in the determination of the design resistance of
column flange in bending. It is possible to omit kfc, so that no reduction for the longitudinal compressive
stress scom,Ed in the column flange ismade. See Ref. [1] J.3.5.5.2 (4)

Capacity beam
flange

This is related to the determination of Fc,fb,Rd ,the determination of the design compression resistance
of the beam flange in compression, for beams stiffened with haunches :
Prof : Mc,Rd will be calculated for the beam cross- section only.

Prof + haunch :Mc,Rd will be calculated for the cross-section consisting of the beam + the haunch(es).

Compr. haunch cfr. SPRINT : For the compressed haunch flange, the Fc,fb,Rd is calculated according
to SPRINT regulations. See also chapter Compression resistance for haunches in Connect Frame :
Theoretical Background.

Use alternative
method for
Ft.Rd.1

This feature allows the user to use an alternative method, given in Ref. [1] J.3.2.4, for the determination
of Ft,Rd for mode 1: Complete yielding of the flange.

Thismethod leads to a higher value of the design resistance for mode 1.

Always adapt
stiffeners

When this option is selected, the thickness of stiffeners will be always changed during the calculation of
the node, depending on actual internal forces and critical limit forces. See Weld size calculation and
Stiffener dimensions in Connect Frame : Theoretical Background.

When this option is not selected, the inputted thickness of stiffeners will be changed only if the inputted
values are smaller than the calculated minimum thickness.

Always adapt When this option is selected, the weld sizes are calculated during the calculation of the node, depend-
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weldsizes

ing on the actual internal forces and the critical limit forces.

When this option is not selected, the default values are taken.

See Weld size calculation and Stiffener dimensions in Connect Frame : Theoretical Background.

Apply stiffness
classification
check

When this option is selected, the stiffness classification and the check of the required stiffness are
applied.

Use internal
forces for weld
size calculation

Check this box for using the internal forces when dimensioning the weld sizes and the stiffeners. If not,
the limit capacities are used.

Use stiffeners
in column web
panel res-
istance

Check this box if you want to use the rectangular stiffeners (in tension and compression zone) in the
capacity of the column web panel in shear.

Use last bolt
only for shear
capacity

Check this box to have at least 1 bolt row which will not be considered in tension. This bolt row is used
for full shear capacity. The bolt is situated the closest to the compression point.

Base plate
Thisgroup determines theway inwhich a base plate isdesigned and calculated.

Apply stiffness
classification
check

When this check box is active, the stiffness classification and the check of the required stiffness are
applied.

Concentration
factor kj

Conservatively kj can be taken as 1.0. For the correct value, consult Ref. [5].

Joint coefficient
betaj

bj may be taken as 2/3 provided that the characteristic strength of the grout is not less than 0.2 times
the characteristic strength of the concrete foundation and the thickness of the grout is not greater than
0.2 times the smallest width of the steel base plate.

Friction coef-
ficient

Fill out the appropriate friction coefficient between mortar and steel.

Fck of concrete
block

Characteristic compressive cylinder strength of the concrete at 28 days.

Good bond con-
dition

Check this box for good bond condition. See EC2 Ref.[6], clause 5.2.2 for more information.

Bar type
High-bond bars: bars with a ribbed surface

Plain bars: bars with a plain surface

Friction included
This option allows you to take account for the friction resistance when determining the shear res-
istance VRd of the joint. Check this box to take account for the friction resistance.

Anchorage type

The Anchorage type describes the way the holding down bolts are anchored into the foundation :

straight: fixing is only based on bond

hooked : The anchors are provided with a hook

curved: see Note 1 below the table

circular plate: A washer plate is provided as the load distributing member

Overlength (d) See definition of anchors in Connection Parts
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Retourlength
hooked anchor
(d)

See definition of anchors in Connection Parts

Retourlength
curved anchor
(d)

See definition of anchors in Connection Parts

Inner radius
hooked anchor
(d)

See definition of anchors in Connection Parts

Inner radius
curved anchor
(d)

See definition of anchors in Connection Parts

Overlength at cir-
cular plate (d)

See definition of anchors in Connection Parts

Thickness cir-
cular plate (d)

See definition of anchors in Connection Parts

Radius circular
plate (d)

See definition of anchors in Connection Parts

Distance from
anchor to side of
concrete block

See definition of anchors in Connection Parts

Anchor length See definition of anchors in Connection Parts

Use support
reactions

When this option is selected, the support reactions are used to design the base plate connection.

If not, the member forces of the column are used to check the connection.

Use internal
forces for anchor
lengths

Check this box in order to use internal forces when dimensioning the anchor length. Otherwise, the
limit capacities are used.

Note 1: Hooked and curved are basically the same types, they only differ in geometrical
properties so they will result in the same anchorage length (curved is provided for future
purposes)

Note 2: Hooked and curved bolt types should not be used for bolts with a specified yield
strength higher than 300N/mm˛ (According toRef. [1] ).

Bolted diagonal
For common bolt diameters (M12 toM36) , the default values for e1 and p1 ( in the diagonal element) and the default values
e1 and e2 (in the plate element) are set for staggered and non-staggered bolt positions.
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Normal force type

The critical normal force for the connection design is searched using the selected criterion:

Tension only only tensile forces are considered

Tension and compression both compression and tensile forces are considered

Partial safety factors
Here, partial safety factorscan be specified.

Symbol Remarks
Default
value

cross- section
and plates

Resistance of Class 1,2 or 3 sections 1.1

members to buck-
ling

Resistance ofmembers to buckling + Class 4 sections 1.1

bolted con-
nection

1.25

welded con-
nection

1.25

prestressed bolts Slip resistance for the ultimate limit state 1.25 

concrete Only used for a base plate connection 1.5

friction plate/-
concrete

Safety factor on friction between steel and concrete. Only used for
a base plate connection.

2
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Partial Safety
fact. Truss

Safety factor on design compression/tension resistance. 1.1

Expert System
The followingRelative errorscan be set:

Section
Sets the admissible relative dimension error for retrieving the connection beam and connection column.
This is only valid when the check on dimensions option is set, or when a VARH section is used, or when
search by name waswithout success.

Material
Sets the admissible relative material error for retrieving the connection materials (i.e. the material prop-
erties for beam, column, endplate, bolt, etc.)

Configuration
The data in the expert database are stored for a certain geometrical configuration. This is measured by
the angle between the beam and the column or the base plate or the endplate. The tolerance for this
angle is defined in the edit box.

Position

This relative error takes into account the difference between the design moment resistance at the top side
and the bottom side. If the relative error between the design moment resistance at the top side and the
bottom side is larger than the value which is set here, an inverted position of the connection will be con-
sidered. This value has no sense for pinned connections.

Order option group
This is the default order option for sorting the relevant connections.

l Unity check: sorting byunity check

l Priority sorting byprioritynumber

Filter options group
The number of entries in the retrieved connection list, can be customized and filtered bymeansof following options:

ucmin

ucmax

Sets limits for the unity check. Only the unity checks, which are inside the boundaries, will be present in the
connection list.

TIP: a good maximum value is 0.90.

priority min

priority max
Sets limits for the priority number.

capacity fil-
ter

The unity check can be based:

on the capacity table values,

on the calculated capacity values or

on a combination of both (minimum or maximum).

bolt
exclude list

For a bolted connection, you can eliminate bolt grades. The connection list will not contain connections
using the selected bolt grades.

source filter Selects the desired sources for retrieving the connections.
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Geometry checks group
This group specifies the criterion for selecting the connection beam and connection column. This can be performed using
the section name (checkon names), or bymeansof section dimensions (checkon dimensions). The checkon namesoption
is the faster one. The check on dimensions option is always used for VARH sections or when the retrieving by names is
without success.

The check on column properties check box should be activated if the user wants to include the column properties for finding
the matching connections. If this is not activated, only the beam properties are consulted. It is obvious that with this last
option, the retrieved unity check can differ from the calculated unity check. The number of retrieved connections will be lar-
ger.

The procedure for adjustment of default parameters

1. Open service Steel:

1. usingmenu function Tree >Steel,

2. or using treemenu function Steel ( ).

2. Open functionConnections>Setup ( ).

3. Adjust the individual parameters in the table as required.

4. Confirmwith [OK].

Making a new connection
The procedure for the definition of a new connection is similar for all analysis types. This chapter presents the general pro-
cedure. The following chapters then dealwith some specificsof individual connection types.

Note: The connection may also be inserted into an intersection of two or more beams
where linked node hasbeen generated.

The general procedure for the definition of a new connection

1. In the graphical window of SCIA Engineer display the part of the structure where the new connection is supposed to be
located.Make especially sure that the appropriate node and beams forming the connection can be clearly seen and easily
selected.

2. Start appropriate function for the required type of connection either using menu function Tree > Steel > Connections >
xxxor using treemenu function Steel >Connections>xxx, where xxxcan be one of the following:

1. Frame bolted / welded - strong axis,

2. Frame bolted / welded - weakaxis,

3. Grid pinned,

4. Bolted diagonal.

3. Select the nodewhere the connection is supposed to be designed.

4. The program automatically selects all the beams that come to or pass through the selected node. If required, deselect
anyof the beams.

5. Press [Esc] to close the function.
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6. The program automatically creates the connection in the selected node. The type of the connection depends on geo-
metrical conditionsand adjusted priorities.

7. The propertywindow displaysall the parameters that are relevant to the specific type of connection.

8. Adjust the parametersof the generated connection in the propertywindow.

9. Clear the selection to finish the design of the particular connection.

Defining a new frame connection in strong axis
The procedure for the definition of a new frame connection in strong axiswill be shown on an example of a horizontal beam
attached to a vertical column in the middle of the column height. However, other configurations are possible as well (e.g.
frame corner, etc.).

The procedure to define a new frame connection in strong axis
Let’shave a columnwith a beamattached to it in themiddle of the column height.

Open service Steel. Start function Connections > Frame bolted/welded – strong axis. Follow the instructions on the com-
mand line and select the point of connection.

All the beams that pass the selected node are selected. If required, unselect unnecessarybeams.
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Press [Esc] to complete the action. The connection is generated in the selected node and a connection symbol is drawn on
the screen.

Use the propertywindow to define all required partsof the new connection.

The connection in the graphicalwindow is redrawn to reflect your settings.
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Note: Remember that a linked nodemust exist in the selected node where connection is to
be defined.

Defining a new frame connection in weak axis
The procedure for the definition of a new frame connection in weak axis will be shown on an example of a horizontal beam
attached to the head of a vertical column. However, other configurationsare possible aswell.

The procedure to define a new frame connection in weak axis
Let’shave a columnwith a beamattached to its top end.

Open service Steel. Start function Connectuions > Frame bolted/welded – weak axis. Follow the instructions on the com-
mand line and select the point of connection.
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All the beams that pass the selected node are selected. If required, unselect unnecessarybeams.

Press [Esc] to complete the action. The connection is generated in the selected node and a connection symbol is drawn on
the screen.

Use the propertywindow to define all required partsof the new connection.
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The connection in the graphicalwindow is redrawn to reflect your settings.

Note: Remember that a linked nodemust exist in the selected node where connection is to
be defined.

Defining a new grid pinned connection
The procedure for the definition of a new grid pinned connectionwill be shown on an example of a horizontal beamattached
to the second horizontal beam in themiddle of its length. However, other configurationsare possible aswell.

The procedure to define a new grid pinned connection
Let’shave two intersecting (joining) horizontal beams.
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Open service Steel. Start function Connections > Grid pinned. Follow the instructions on the command line and select the
point of connection.

All the beams that pass the selected node are selected. If required, unselect unnecessarybeams.

Press [Esc] to complete the action. The connection is generated in the selected node and a connection symbol is drawn on
the screen.
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Use the propertywindow to define all required partsof the new connection.

The connection in the graphicalwindow is redrawn to reflect your settings.

Note: Remember that a linked nodemust exist in the selected node where connection is to
be defined.

Note: The beam that passes the connection must have HIGHER priority than the beam
that ends in the connection. E.g. like below:
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The priority can be adjusted in the property dialogue of each beam in the field Type or in
groupCADmodel:

Defining a new bolted diagonal connection
The procedure for the definition of a new bolted diagonalwill be shown on anmodel example of a vertical columnwith a diag-
onal attached to it. However, other –more realistic– configurationsare possible aswell.

The procedure to define a new bolted diagonal connection
Let’shave themodel situation.
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Open service Steel. Start function Connectuions > Bolted diagonal. Follow the instructions on the command line and select
the point of connection.

All the beams that pass the selected node are selected. If required, unselect unnecessarybeams.

Press [Esc] to complete the action. TheBolted connection dialogue isopened on the screen.Make necessaryadjustments.
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The connection isgenerated in the selected node and a connection symbol isdrawn on the screen.

The connection in the graphicalwindow is redrawn to reflect your settings.
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Note: Remember that a linked nodemust exist in the selected node where connection is to
be defined.

Specifying the parameters of connection
Once a connection is created, itsparametersmaybe displayed in the propertywindow, adjusted andmodified in order to sat-
isfyall the requirements laid on the particular connection.

The parameters, of course, depend on the connection type that is being edited. Knee connection will have different para-
meters in the table than e.g. plate-to-plate connection. If more that one connection is edited at the same time (i.e. more than
one connection is selected), the intersection of the parameters common to all selected connections is displayed in the prop-
ertywindow.

The property table also hides all the "illogical" parameters. For example, unless the user specifies that there are bolts in the
connection, it is not possible to select their length, diameter and other parameters.

In order tomake the design of connection a straightforward action, the parametersare sorted in separate groups. The user
may either open or close the group in the property window. It may be a good practice to close those groups whose design
hasbeen finished. Thus the list of parameters in the propertywindow becomesshorted and clearer.

Overview of connection parameter groups
The following overview presents the groups of parameters that may appear in the propertywindow. Some groups of para-
metersor some particular parameters in groupsmaybe available only for specific connection type or types.

Basic (ungrouped) parameters
Name Specifies the name that appears in outputs.

Type of loads
Specifies the "type of load" that is used for calculations (checking) of the connection. E.g. load cases or
load case combinationsmay be selected.

Frame type Specifies the type of the frame. The frame may be with bracing or without it.

Connection
geometry

Informs the user about the geometrical type of the connection.

Side => [Beam name]
Several beamsmaycome to the connection. Each of the beamshasgot an individualSide group in the table.
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The parameters in the group define which particular parts form the particular connection. The contents of the group may
varyaccording towhich parametershave been alreadyspecified in the group.

Possible parameters in theSide group are:

Connection type Either frame bolted or frame welded connection can be designed.

End plate Specifies that an end plate is used.

Backing plate Specifies that a backing plate is used.

Bolts Specifies that bolts are used.

Top stiffener Specifies that a top stiffener is used.

Bottom stiffener Specifies that a bottom stiffener is used.

Diagonal
stiffener

Specifies that a diagonal stiffener is used.

Web doubler Specifies that the web of the column is stiffened by a web doubler.

Update cal-
culation

If this option is ON, the program calculates the resistance and stiffness of the connection and displays
them in the table at the end of Side group.

Calculation type
Specifies the load conditions in the connection. If the type is set to "for load cases and combinations",
the program performs also the checking of the connection. And again the results are shown in the
table at the end of Side group.

Output
Each connection may be "exported" into the document. Option Output then specifies the extent of the
output report generated in the document.

Length for stiff-
ness clas-
sification

Specifies the length for stiffness classification.

Update stiffness Automatically calculates the stiffness of connection.

Element type (for
Frame Pinned)

Selects type of plate for frame pinned connection.

Pinned plate (for
Frame Pinned)

Specifies that a pinned plate is used.

Cleat (for Frame
Pinned)

Specifies that a cleat is used.

Save to expert
database

Saves the connection to expert database.

Load from expert
database

Loads a connection from expert database.

Beam notch (for
Grid Pinned)

The shape and size of the cleat.

Node (for Bolted
Diagonal)

Informs about the node where the connection is defined.

Gussetmaterial
(for Bolted Diag-
onal)

Defines the gussetmaterial.

Edit Bolted Diag-
onal (for Bolted
Diagonal)

Provides for editing of this type of connection.

Haunch
Adds a haunch to the connected beam. This haunch:

l affects the check of the connection,
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l is taken into account when calculating the substitute" stiffness of he connection (if option Update
stiffness is ON),

l is ignored in the calculation model itself (unlike the haunch defined bymeans of function Structure
> Haunch.

End plate
Thisgroup of parametersspecifiespropertiesand dimensionsof the end platewelded to the connected beam.

Backing plate
Thisgroup of parametersspecifiespropertiesand dimensionsof the backing plate.

Bottom stiffener
Thisgroup of parametersspecifiesproperties, shape and dimensionsof the bottom stiffener.

Top stiffener
Thisgroup of parametersspecifiespropertiesand dimensionsof the top stiffener.

Diagonal stiffener
Thisgroup of parametersspecifiespropertiesand dimensionsof the diagonal stiffener.

Web doubler
This group of parameters specifies properties, type and dimensions of the web doubler. It also automatically calculates the
size of the element.

Pinned plate
Thisgroup of parametersspecifiesproperties, type and dimensionsof the pinned plate.

Cleat
Thisgroup of parametersspecifiesproperties, type and dimensionsof cleat.

Bolts
Here, the bolt assembly, pattern, distance and other parametersconcerning boltsare specified.

Stiffener between bolt rows
Thisgroup of parametersspecifiespropertiesof the stiffener between bolt rows.

Weld
Thisgroup specifiesparametersof weld used in the connection.

Concrete data
Thisgroup summarisespropertiesof concrete block towhich a steel beam is fixed bymeansof anchors.
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Anchor data
TheAnchor data group provides for input of anchor type, shape and properties.

Example:

Let’s assume a standard knee connection of a column and a beam. There will be only one
Side group in the table. It will contain parameters:

l end plate,

l top stiffener,

l bottom stiffener,

l diagonal stiffener,

l web doubler.

As soon as the user inserts an end plate to the connection, two more parameters are
added to the group:

l backing plate,

l bolts.

Further let’s assume that the user specifies the bolts in the connection. At that moment the
connection becomes "realistic" and new itemsare added to the group:

l update calculation,

l calculation type,

l output.

Bubble help: The editing and adjusting of individual connection parameters is quite easy
thanks to a sophisticated feature implemented in the propertywindow. Whenever the user
places the mouse cursor over a value cell in the table, the program shows a "bubble" help
that brings a simple drawing explaining the meaning of the particular parameter. For
example, the picturesbelow explain the difference between a small and largeweb doubler.
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Expert System
For Frame connections (bolted, welded and pinned), a connection database isavailable. The contentsof thisdatabase con-
sists of some pre-defined connections and can hold user defined connections. Besides the geometrical data, the capacity
propertiesand the stiffnessproperties for a given configuration are saved in thisdatabase. The capacity and stiffnessvalues
are based on the ultimate limit state of the joint.

During the input of the connection data, thisdata can be searched in the expert database.

Bymeansof variousoptions, the user can customise and filter the search algorithm in the database.

Contents

The predefined connections
The predefined connectionsare based on the following tables:

Bemessungshilfen für profilorientiertes Konstruieren

Auflage 1997

Stahlbau-Verlagsgesellschaft mbHKöln

Stahlbau Kalender 1999

Bemessungshilfen für nachgiebige Stahlknoten mit Stirnplattenanschlüssen

Ernst & Sohn, DSTV, 1999, Berlin

The capacitydata are introduced as table values.

A supplementary set for predefined connections is generated by SCIA Engineer. The capacity data are introduced as cal-
culated values.

The predefined connectionsare locked, and cannot bemodified.

To reduce the number of data in the database, the predefined connections are based on beam properties. This implies that
the proposed unity checkduring the search algorithm can be different from the calculated unity check.

User defined connections
A second part of the database consists of user-defined data, which he can input and delete. For this data, both beam and
column data are considered. The capacitydata are introduced ascalculated values.

Load from expert database
For each relevant side the best- fitted connection data is represented by its connection name and the graphical rep-
resentation. The best fitting result is the connectionwith the largest unity checkbut lower than 1.

[OK] button accepts the proposed connections; [Cancel] button ignores the proposed connections.

A complete list of thematching connections isgiven.

This connection list isbased on the following search criteria:

l the joint type (welded, bolted, pinned) ismatching,

l the geometrical type (beam-column, beam-beam, base plate) ismatching,

l the angle between column and beam isbetween given limits (see chapter Adjusting the default parameters),
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l the beamproperties (geometryandmaterial) are between given limits (see chapter Adjusting the default parameters),

l the column properties (geometryandmaterial) are between given limits (see chapter Adjusting the default parameters),

l check for local constraints ( for example : haunch at the top isnot alwayspossible for a knee connection, check for admiss-
ible pitch,…).

If these conditionsaremet, the connection data are retrieved and sorted in unity checkorder or in priorityorder (see chapter
Adjusting the default parameters).

For each entry, the connection name, the unity check, the position (normal or inverse), the bolt grade, the source name and
the priorityare present.

Example

IH3E/IPE270/16/20 0.99 +DSTV10.9 1

Example

Connection name IH3E/IPE270/16/20

Unity check 0.99

Position +

Source DSTV

Bolt grade 10.9

Priority 1

  For welded and bolted beam-column and beam-beam connections, the unity check is based on the moment capacity. For
bolted base plate connections, the unity check is based on moment capacity and normal force capacity. For pinned con-
nections, the unity check isbased on shear force capacity.

The capacity of the connection can be based on the calculated value, or on the table value or on both values (see chapter
Adjusting the default parameters).

A selected connection can bemodified byselecting the proper entry in the list.

Saving the connection into the expert database
Each side can be saved to the connection database. The user has to specify a unique name for the connection. The default
name of the connection is composed as follows:

AA/B/CCCCCC/DDDDDD/EE/FFFFFF/G

AA Geometrical configuration

BC : beam-column

PP : plate-to-plate

BP : base plate

B Joint type

B : bolted

W :welded

P : pinned

CCCCCC Beam section

DDDDDD Column section

EE
Endplate thickness (if bolted)

Pinned type (if pinned)

FFFFFF Bolt diameter and bolt grade (if bolted)

G Number
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Examples:

BC/B/IPE270/HEA260/20/M16-10.9/1

Bolted beam-to-column connection between an IPE270 beam and a HEA260 columnwith endplate thickness= 20mmand
bolt M16 (10.9).

PP/B/IPE270/30/M20-10.9/1

Bolted plate-to-plate connection on an IPE270 beamwith endplate thickness=30mmand bolt M20 (10.9).

BP/B/HEA260/15/M16-10.9/1

Bolted base plate connection on aHEA260 columnwith base plate thickness=15mmand anchor M16 (10.9).

BC/W/IPE270/HEA260/1

Welded beam-to-column connection between an IPE270 beamand aHEA260 column.

PP/W/IPE270/1

Welded plate-to-plate connection on an IPE270 beam.

BC/P/IPE270/HEA260/T/1

Pinned beam-to-column connection between an IPE270 beamand aHEA260 column using pin type 1.

Defining the bolt assembly
By default, the user selects from an excessive catalogue of prepared bolt assemblies. However, if required, he/she may
define his/her own bolt assembly or edit the existing one. The bolt assembly specifies which bolts are used with which nuts
andwashersand definespropertiesof them.

Bolts
Selected bolt Selects the particular bolt.

Type Chooses either normal or pre-stressed bolt.

Bolt grade Specifies the grade.

Ultimate tensile strength Informs the user about the ultimate tensile strength of the selected bolt.

Bolt length

Defines the way the bolt length is defined:

l standard length

l grip + delta (common in the U.S.)

Length Specifies the length of the bolt.

Grip limit - lower Specifies the lower grip limit.

Grip limit – upper Specifies the upper grip limit.
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Nuts
Selected nut Selects the particular nut.

Nut grade Specifies the grade.

Washers
Washer at head Sayswhether the washer is present at the head of the bolt.

Washer at nut Says whether the washer is present at the nut.

Selected washer Selects the particular washer.

The procedure for the definition of bolt assembly

1. Have the connection propertiesdisplayed in the propertywindow:

1. thishappensduring the definition of a new connection,

2. or when an existing connection hasbeen selected for editing.

2. Make sure that itemBolts is selected in the connection property table.

3. In the required table group Bolts (there may be several Bolts groups in the table, one group per each beam in the con-
nection) press the button at the right hand side of item Selected bolt assembly (

).

4. The Bolt assemblymanager opens on the screen (The manager is one of many SCIA Engineer managers and its oper-
ation isunified throughout thewhole SCIAEngineer environment.).

5. Define a new bolt assemblyor edit the existing one as required.

6. Close theBolt assemblymanager.

7. Use the new bolt assemblywhere required.

Selecting the bolts
SCIA Engineer offers a long list of common bolts. The library contains all necessary information which is crucial for the
proper design of connections.

If necessary, the user may edit the data related to bolts in the Boltsmanager. The manager is one of many SCIA Engineer
managersand itsoperation isunified throughout thewhole SCIAEngineer environment.

The procedure for definition of bolt

1. Invoke theBolt assemblymanager and have it displayed on the screen.

2. Press the button at the utmost right end of itemSelected bolt.

3. Thisbutton opens theBoltsmanager on the screen.

4. Define a new bolt or edit anyof pre-defined ones.

5. Close theBoltsmanager.
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Selecting the nuts
SCIAEngineer offersa long list of commonlyused nuts. The library containsall necessary informationwhich is crucial for the
proper design of connections.

If necessary, the user may edit the data related to nuts in the Nuts manager. The manager is one of many SCIA Engineer
managersand itsoperation isunified throughout thewhole SCIAEngineer environment.

The procedure for definition of nut

1. Invoke theBolt assemblymanager and have it displayed on the screen.

2. Press the button at the utmost right end of itemSelected nut.

3. Thisbutton opens theNutsmanager on the screen.

4. Define a new nut or edit anyof pre-defined ones.

5. Close theNutsmanager.

Selecting the washers
SCIA Engineer offers a long list of commonly used washers. The library contains all necessary information which is crucial
for the proper design of connections.

If necessary, the user may edit the data related to washers in the Washers manager. The manager is one of many SCIA
Engineer managersand itsoperation isunified throughout thewhole SCIAEngineer environment.

The procedure for definition of washer

1. Invoke theBolt assemblymanager and have it displayed on the screen.

2. Press the button at the utmost right end of itemSelectedwasher.

3. Thisbutton opens theWashersmanager on the screen.

4. Define a newwasher or edit anyof pre-defined ones.

5. Close theWashersmanager.

Editing the existing connection
Modifying the parameters of connection
Generally speaking, connection defined in SCIA Engineer is nothing more than an extra information saved with the struc-
ture model. From this point of view, it can be compared to e.g. load, support, mass, etc. And similarly to the named entities
the connectionsbelong to theAdditional data.

Consequently, anyconnection can be easilymodified using the samewayasadditional data are edited.

The procedure for the modification of parameters of connection

1. Select the connection or connections that should bemodified.

2. The intersection of properties for the selected connections isdisplayed in thePropertywindow.

3. Change the parametersas required.
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4. The change isautomaticallyapplied.

5. Clear the selection.

If only a single connection should be modified and the user would prefer to see a regular modal dialogue on the screen, an
alternative approachmaybe used.

The alternative procedure for editing of connection

1. Position themouse cursor over the connection that should bemodified.

2. Click the rightmouse button.

3. The graphicalwindow pop-upmenu appear on the screen.

4. Select function Edit properties.

5. The propertydialogue for the selected connection isopened in a separatemodal dialogue.

6. Change anyparametersyou need tomodify.

7. Confirm the changeswith button [OK].

8. The operation is completed.

Copying the connection
Generally speaking, connection defined in SCIA Engineer is nothing else than an extra information saved with the structure
model. From this point of view, it can be compared to e.g. load, support, mass, etc. And similarly to the named entities the
connectionsbelong to theAdditional data.

Consequently, anyconnection can be copied to another node the samewayasadditional data are copied.

The procedure for copying of connections

1. Select the connection that is to be copied.

2. IconCopyadd data ( ) becomesaccessible on toolbar Geometricalmanipulations.

3. Click the icon.

4. Define the target position for the copied connection.

5. The selected connection is copied into the new location.

6. If required, select another target positions.

7. Press [Esc] to and the function.

The function for copying of additional data is also accessible via the window pop-up menu. Instead of clicking the button on
theGeometricalmanipulations toolbar, it is possible to use the alternative approach.

The alternative procedure for copying of a connection

1. Select the connection that is to be copied.

2. Position themouse cursor outside anyentityon the screen.

3. Click the rightmouse button to invoke the pop-upmenu.

4. Select functionCopyadd data ((

- 71 -



Chapter 4

)).

5. Follow the final stepsof the procedure described above.

There isalso an alternative to the abovementioned procedure.

The second alternative procedure for copying of a connection

1. Position themouse cursor over the connection youwant to copy.

2. Click the rightmouse button.

3. The pop-upmenu appearson the screen.

4. Select functionCopyadd data (( )).

5. The functionwill treat the single entity – the one over which themouse cursor waspositionedwhen themouse buttonwas
clicked.

6. Define the target position for the copied connection.

7. The selected connection is copied into the new location.

8. If required, select another target positions.

9. Press [Esc] to and the function.

Deleting the connection
Generally speaking, connection defined in SCIA Engineer is nothing more than an extra information saved with the struc-
ture model. From this point of view, it can be compared to e.g. load, support, mass, etc. And similarly to the named entities
the connectionsbelong to theAdditional data.

Consequently, anyconnection can be deleted the samewayasadditional data are deleted.

The procedure for deletion of connections

1. Select connections that should be removed.

2. Start functionDelete:

1. either usemenu functionModify>Delete,

2. or invoke thewindow pop-upmenu and here select functionDelete.

3. Adialogue asking for your confirmation appearson the screen.

4. Confirm it.

5. The connectionsare deleted from the project.
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Checking the connection

Fast checking
Fast checking of a selected connection can bemade in the property table.

Once a connection is selected and its properties are shown in the property window (see chapter Modifying the parameters
of connection), it is possible to displaybrief information about the bearing capacityof the connection.

Group Side (remember that each beam coming to the connection has got its own group Side) contains item Update cal-
culation. When this item is ticked (selected), the program calculates automatically the design resistance of the connection
and someother characteristics.

Design moment res-
istance

Shows the overall moment resistance of the connection.

Design shear resistance Shows the overall shear resistance of the connection.

Design normal res-
istance

Shows the overall normal resistance of the connection.

Result of stiffness, Sj Displays the rotational stiffness of the connection, related to the actual momentMj,Sd.

Result of stiffness, Sj,ini Displays the rotational stiffness, related to Mj,Rd (without the influence of normal force).

Limit part
Tells which part is the limiting part of the connection. In other words, which part is the most
"weak" part.

Limit part compression Tells which part is the limiting part of the connection in compression.

The above mentioned quantities are shown if Calculation type for the particular "side" of the connection is set to tension on
top side or tension on bottom side. These two options mean that the program does not assume existence of results cal-
culated in staticanalysisof the structure.

However, if optionCalculation type isset to from load case / combination, the program takes the available resultsof static cal-
culation and determinesother result values related to the connection.

Unity checkM /MRd Displays the result of unity check for moment.

Unity check V / VRd Displays the result of unity check for shear force.

Unity check N / NRd Displays the result of unity check for axial force.

Moment Displays the actual moment acting in the connection.

Shear force Displays the actual shear force acting in the connection.

Check – Moment Displays the result of moment check.

Check – Shear force Displays the result of shear force check.

Note 1: In order to enable the program to show the basic checking results, i.e. the res-
istance and stiffness values, the connection must be already defined reasonably. That
means that it must contain at least the most essential parts. For example, the knee con-
nectionmust contain an end plate and bolts.

Note 2: In order to enable the program to show the results of complete check (i.e. the val-
ues from the second table), the condition from Note 1 must be fulfilled and the structure
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model must have been already calculated and at least one result of that analysis must be
available.

Detailed checking
Once a connection isdesigned, the program isable to perform the checking of the connection and show the results. The res-
ultsmaybe presented in a brief form directly in the property table of the connection, or theymaybe sorted out in a readable
tabular style in the document.

brief The output brings just the principal data related to the connection.

normal The output contains the all the essential information about the connection and its checking.

detailed The report consists of all available data related to the connection.

Regardlessof the output type, the result report isgenerated into the document or previewwindow of SCIAEngineer.

The procedure for creation of output in Preview window

1. Select the connection or connections that should be checked.

2. The intersection of properties for the selected connections isdisplayed in thePropertywindow.

3. Set itemOutput to the required value (brief / normal / detailed).

4. Call function Print / Preview table:

1. either using function Print data >Print / Preview table located onProject toolbar,

2. or usingmenu function File >Print data >Print / Preview table.

5. The programgenerates tables for selected connection (or connections) in the Previewwindow.

The procedure for creation of output in the Document

1. Select the connection or connections that should be checked.

2. The intersection of properties for the selected connections isdisplayed in thePropertywindow.

3. Set itemOutput to the required value (brief / normal / detailed).

4. Call function Table to document:

1. either using function Print data >Table to document located onProject toolbar,

2. or usingmenu function File >Print data >Table to document.

5. The programgenerates tables for selected connection (or connections) in theDocument.

Checking summary
Checking of a connectionmaybe carried out once two basic conditionsaremet:

l the connection hasbeen designed,

l the project hasbeen successfully calculated and resultsare available.

The checking results in a brief table containing the essential data about the connection, its resistance and the load it is sub-
ject to.
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The procedure for checking the connection

1. Open service Steel.

2. Open branchConnections.

3. Select functionCheck.

4. In the Propertywindow, adjust the required checking parameters.

5. Use function Print >Print / Preview table to display the results in the Previewwindow.

Checking parameters

Selection

The selection may set to:

All – all beams are checked

User – the user must select beams for the checking

Type of load The checking may be carried out for load cases or for combinations.

Load case Here the specific load case or combination may be selected.

Filter

Filter may be se to:

No – there is no filtering

Wildcard – the selection is given by the typed "wildcard expression", e.g. B*, BEAM1?, etc.

Values Here the required quantity may be selected.

Extreme This item tells which connections should be presented in the PreviewWindow (see below).

Extreme
No / Node All selected connections are checked and printed.

Global All selected connections are checked, but only the one with extreme value is printed.

The tablewith the resultsmay look like:

Note: Once the PreviewWindow is opened and the results of connection checking are dis-
played in it, any change of the checking parameters leads to the regeneration of the Pre-
view Window. There is no need to use function Print > Print / Preview table over and over
again.
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Output of connections

Screen visualisation
Introduction to screen visualisation
Aconnection can be drawn on the screen both during the phase of design andwhen finished to the latest detail.

There are several view stylesavailable in SCIAEngineer. Each style has itsadvantagesand isuseful for different purposes:

l simplified view,

l rendered view,

l viewwith dimension lines,

l user-specific view.

Simplified view
Simplified view (called also wired view) displays all the parts of the connection in the form of "wires" or separate lines. This
style isadvantageous for its speed. Veryoften it isalso clear enough and can be recommended as the basicdisplaystyle.

Simplified (wired) view of calculation model
The procedure for the adjustment of simplified view

1. Call menu function View > Set view parameters > Model of structure (this sets the view of the calculation model of the
structure).

2. If the structure isdisplayed in renderedmode, clickbutton [Render geometry] at the bottom side of the graphicalwindow.

3. In the graphicalwindow click the rightmouse button to invoke the pop-menu.

4. Select function Set view parameters.

5. Select tab Entities.

6. In group of view parameterscalled Steel connectionsset the following parameters:

1. tick the parameter Display,

2. parameter Rendering set to valueWired.

7. Confirmwith [OK] (this sets the simplified view of the connections).

Example
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Simplified (wired) view of CAD model
The procedure for the adjustment of simplified view

1. Callmenu function View >Set view parameters>CADmodel (this sets the view of theCADmodel).

2. If the structure isdisplayed in renderedmode, clickbutton [Render geometry] at the bottom side of the graphicalwindow.

3. In the graphicalwindow click the rightmouse button to invoke the pop-menu.

4. Select function Set view parameters.

5. Select tab Entities.

6. In group of view parameterscalled Steel connectionsset the following parameters:

1. tick the parameter Display,

2. parameter Rendering set to valueWired.

7. Confirmwith [OK] (this sets the simplified view of the connections inCADmodel).

Example
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Rendered view
Rendered view displays all the parts of the connection with full "visibility" of individual parts. In
other words, those parts that are located behind others are invisible. The viewmost resembles of
normal view of the structure in reality. This style is advantageous for its punctuality. It may be use-
ful for design of complex details and for good visualisation of designed connections. It is also almost
invaluable during presentations.

Rendered view of calculation model
The procedure for the adjustment of rendered view

1. Call menu function View > Set view parameters > Model of structure (this sets the view of the calculation model of the
structure).

2. If the structure isdisplayed inwiredmode, clickbutton [Render geometry] at the bottom side of the graphicalwindow.

3. In the graphicalwindow click the rightmouse button to invoke the pop-menu.

4. Select function Set view parameters.

5. Select tab Entities.

6. In group of view parameterscalled Steel connectionsset the following parameters:

1. put the tick into the itemDisplay,

2. parameter Rendering set to valueRenderedwith edges.

7. Confirmwith [OK] (this sets the rendered view of connections).

Example

Rendered view of CAD model
The procedure for the adjustment of simplified view

1. Callmenu function View >Set view parameters>CADmodel (this sets the view of theCADmodel).

2. If the structure isdisplayed inwiredmode, clickbutton [Render geometry] at the bottom side of the graphicalwindow.
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3. In the graphicalwindow click the rightmouse button to invoke the pop-menu.

4. Select function Set view parameters.

5. Select tab Entities.

6. In group of view parameterscalled Steel connectionsset the following parameters:

1. tick the parameter Display,

2. parameter Rendering set to valueRenderedwith edges.

7. Confirmwith [OK] (this sets the rendered view of the connections inCADmodel).

Example

Dimension lines
SCIA Engineer enables the user to display also dimension lines for individual connection parts. The dimension lines can be
switched on in Set view parametersdialogue.

The style of dimension linescan be set in Setup >Dimension linesdialogue.

Example
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View parameters
Connections, similarly to other SCIAEngineer entitieshave parameters that control the displaystyle. These parametersare
called view parameters. The user may adjust the view parameters almost arbitrarily in order to find such a display style that
most reflectshis/her needs, wishes, demands, or habits.

The procedure for adjustment of view parameters for connections

1. In the graphicalwindow click the rightmouse button to invoke the pop-menu.

2. Select function Set view parameters.

3. Select tab Entities.

4. Adjust the required parameters in groupSteel connections.

5. Confirmwith [OK].

Example of viewwhere the connection isdisplayed in renderedmode and the structure inwiredmode
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Example of viewwhere the connection isdisplayed in "transparent rendering" mode and the structure inwiredmode

Drawings
Inserting a selected drawing into the Document
Any drawing of any connection that is just displayed on the screen may be inserted as a separate drawing into the Docu-
ment.

The procedure for the insertion of a connection drawing into the Document

1. Adjust the drawing on the screen as required.

2. Call function Picture to document:

1. usingmenu function File >Print picture >Picture to document,

2. using function Print picture >Picture to document ( > ) on toolbar Project

- 81 -



Chapter 6

3. Adjust the parametersof the picture.

4. Confirmwith [OK].

Inserting a selected drawing into the Picture gallery
Anydrawing of anyconnection that is just displayed on the screenmaybe inserted asa separate drawing into thePicture gal-
lery.

The procedure for the insertion of a connection drawing into the Picture gallery

1. Adjust the drawing on the screen as required.

2. Call function Picture to gallery:

1. usingmenu function File >Print picture >Picture to gallery,

2. using function Print picture >Picture to gallery ( > ) on toolbar Project,

3. using button [Pictureto gallery] ( ) located at the bottom scroll bar of the graphicalwindow.

3. Type the nameof the picture.

4. Confirmwith [OK].

Printing a selected drawing of connection
Anydrawing of anyconnection that is just displayed on the screenmaybe printed asa separate drawing.

The procedure for the printing of a connection drawing

1. Adjust the drawing on the screen as required.

2. Call function Print picture:

1. usingmenu function File >Print picture >Print picture,

2. using function Print picture >Print picture ( > ) on toolbar Project

3. Adjust the parameters of the picture.
4. Confirmwith [OK].

Saving a selected drawing into external file
Any drawing of any connection that is just displayed on the screen may be saved as a separate drawing into an external
graphical file.

The procedure for the exporting of a connection drawing

1. Adjust the drawing on the screen as required.

2. Call function Save picture to file:

3. usingmenu function File >Print picture >Save picture to file,

4. using function Print picture >Save pictureto file (
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> ) on toolbar Project

5. Adjust the parametersof the picture.

6. Confirmwith [OK].

Generating the drawings by Picture wizard
It is usual practice that awhole set of drawings isnecessary to describe fullyall partsof the connection:

l variousviewsof the connection,

l drawingsof individual parts such asbacking plate, stiffener, etc.

SCIAEngineer enables the user to call a sophisticated tool called Picturewizard that doesall thework for the user.

The wizard asks the user to decide which drawings are required and what their style should be, and
then generates a set of specified pictures.

The parameters of the Picture wizard

Name Prefix
Prefix of name Specifies the base of picture name.

Scale Determines the scale in which the picture ismade.

Picture parameters
Picture width Specifies the width of the picture.

Picture height Specifies the height of the picture.

Displaymode

Specifies the mode of the drawings:

normal

rendered

wired

hidden lines off

hidden lines dashed

wired OpenGL

Text scale factor
This factor can be used to multiply the text size in order to adjust easily the drawing for various out-
put devices.

Character set of
texts

Specifies the character set (e.g.Western Europe, Eastern Europe,Greek, Russian, etc.)

Dimension line
End-mark style Specifies the style of end marks of dimension lines.

End-mark size Specifies the size of end marks of dimension lines.

Text size Specifies the size of text of dimension lines.
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Other picture parameters
Placement of name Defines the position of drawing name on the sheet.

Name font size Defines the font size for the drawing name.

Wizard parameters

Draw connections

The user may specify which defined connections should be considered by the wizard:

l drawings are made for all connections defined in the project,

l drawings are made for selected drawings only.

View parameters

The drawings can be made using:

l view parameters of the active graphical window,

l view parameters assigned to CAD types.

Whole connection – Front view If ON, front view of the connection is drawn.

Whole connection – Side view If ON, side view of the connection is drawn.

Parts of connection If ON, drawings of connection parts are generated aswell.

Example

The picture below shows the Picture gallery dialogue. The top left window lists the generated drawings for a particular con-
nection. The bottom right window then shows the preview of selected picture.
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Document
Inserting a connection drawing into the Document
Any drawing of any connection that is just displayed on the screen may be inserted as a separate drawing into the Docu-
ment. Later the documentmaybe edited in awayso that the final report looksasprofessional aspossible.

The procedure for the insertion of a connection drawing into the Document

1. Adjust the drawing on the screen as required.

2. Call function Picture to document:

1. usingmenu function File >Print picture >Picture to document,

2. using function Print picture >Picture to document ( > ) on toolbar Project

3. Adjust the parametersof the picture.

4. Confirmwith [OK].

Inserting a table with connection data into the Document
Data related to any connection that has been defined in the project may be inserted into the Document in the form of read-
able tables. Later the documentmaybe edited in awayso that the final report looksasprofessional aspossible.

The procedure for the insertion of a table with connection data into the Document

1. Adjust the drawing on the screen as required.

2. Call function Table to document:

1. usingmenu function File >Print data >Table to document,

2. using function Print data >Table to document on toolbar Project
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Relation to other modules

Geometry and internal forces
ModuleConnections reads from the basicmodule of SCIAEngineer all the information about:

l geometry including cross-sections,materials, dimensions, etc.

l calculated internal forces (on condition that the calculation hasbeen alreadycarried out).

These data are used as the basis for the design and check of individual connections. The user does not have to take care
about the proper definition of load that the particular connection is subject to. The programdoes it automatically.

Recognition of haunches
If a haunch comes into the connection, the program is capable of recognising such a case. The design of the connection is
then modified accordingly. There is no need to specify explicitly that a particular connection is a connection of beams with
haunches.

The picturesbelow show the designed connection of a "normal" beamand of a beamwith a haunch.

Connection of "normal" beam
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Connection of haunch beam

Check of stiffness
The connection is classified as rigid, pinned or semi-rigid according to its stiffness by using the initial rotational stiffnessSj,ini
and comparing thiswith classification boundariesgiven inRef.[1] Figure J.8.

The program calculates the real stiffness of the designed connection and displays it together with other results for the con-
nection.

Updating the stiffness of calculation model
SCIAEngineer module for design and checking of connections is capable of automatic determination of the connection stiff-
ness.What’smore, the programcan also use this stiffnessasan input data for the calculation of themodel.

Thus, the following procedure of accurate analysisof a structure ispossible:

1. creation of the structuremodelwith default, rigid connectionsof individualmembers

2. calculation of themodel and determination of "first-round" results

3. thorough design on connections (i.e. definition of end plates, stiffeners, bolts, welds, etc.)

4. automatic calculation of stiffness for individual connections

5. re-calculation of thewholemodel, this timewith proper stiffnessof individual connections

6. final review, checking and generation of printed documentation

Switching the automatic update ON
In order to obtain automatically the stiffness of individual connections in the model, the user must ONLY check item Update
stiffness located in groupSide in the property table of the particular connection.

Item Update stiffnessmust be checked separately for each connection where the stiffness is required to be used in the cal-
culation.
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Obtaining the results that reflect the connection stiffness
Once the Update stiffness item has been selected for required connections, the calculation of the model MUST be carried
out oncemore.

This repeated calculation performs two tasks:

1. it generateshinges in appropriate jointsand defines their stiffnessaccording to the designed connection,

2. it performscalculation.

Note 1: The hinges defined automatically in selected connections, remain a permanent
part of the calculation model. Even if the Update stiffness option is cancelled, the already
defined hinges remain in the structure. If the user wants to remove them, he/she must do
somanually.

Note 2: If the design of a particular connection hasbeen changed after the re-calculation of
the model, and item Update stiffness for that modified connection is ON, it is necessary to
repeat the calculation once more in order to modify also the stiffness of the automatically
generated hinge.
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